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Introduction  
The Scala archive is a collection of tuning files maintained by Manuel Op de Coul, the creator 
of Scala, at the Fokker foundation website http://www.huygens-fokker.org/scala/
downloads.html#scales Over the last two decades, the Scala tuning archive has grown to over 
four thousand scales. Such a vast store of tunings is a bit overwhelming, especially for 
newcomers. ScalaVista provides the means to quickly see what is in the archive, to hear the 
sounds, and to easily explore them. 

First appearing in 2009, with permission from Manuel Op de Coul, the original version of 
ScalaVista was freeware, and worked directly with Scala text files, and had no way of reliably 
correlating the scales on a user’s machine with the scales in the current Scala archive. It was 
left to the user to keep his or her archive up to date. While this approach allowed a certain 
kind of flexibility for the user, it also was a bit confusing, and somewhat error prone. 

In 2013, I decided it was time to overhaul the design of ScalaVista, to turn it into a true 
database app, and to link it with the growing Scala archive, which had already increased by 
hundreds of scales. With permission, I programmed an online searchable database from the 
existing Scala archive, as an addition to the H-Pi Instruments website. This archive allowed 
searching for matching text within the parameters of the Scala format: filename, description, 
tone count, and tones. 

ScalaVista desktop is a much more advanced database allowing more specific searching using 
comparators as well as matching, introducing advanced search options and advanced 
functionality, and most importantly allowing the tones of every scale to be heard and 
compared quickly and easily. 

Interface Basics 
ScalaVista offers a straightforward single-window interface that should not require much 
explanation; however, one thing which is good to know at the outset is that you can open up 
as many database windows as you like.  

Opening more than one database window allows you to perform different kinds of searches 
without losing the results. If there are results you want to keep visible while performing more 
searching, just open a new window using the menu item File > New Window or Command-N. 
The new window will be labeled in its titlebar with an index number, so you can keep track of 
which window you opened in what order. 

The ScalaVista desktop app allows maintaining local searchable access 
to the continually expanding Scala archive of over 4000 scales.
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Use the mouse to Right-Click or Control-click on the database list to bring up a menu 
providing quick access to many useful actions which are explained in this documentation. 

 

Bug Reporting and Feedback 
Please report any problems you may experience with ScalaVista directly by using the menu 
item Report a Bug. Before doing so, please also check the ScalaVista reports webpage, which 
lists all known issues and feature requests. Your ideas and suggestions for improving the 
software are welcome. Please send feedback and suggestions by email directly or using the 
menu item Send an Email.  

I ask kindly that you do not post complaints in Mac App Store Reviews, as I have no 
way of corresponding with you to correct the problem in that case. When you report 

bugs directly as described above, I can work with you to resolve the issue. 
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1. Preferences 

 
When you open ScalaVista for the first time, the Preferences window is opened, so that you 
can select some basic options, which should be fairly self-explanatory. Details are as follows. 

Display 

 
The database display window shows a list of scale information, which can be substantively 
and cosmetically tweaked in the Preferences window. 

The Font Size can be selected by the user,  to accommodate various screen sizes and 
resolutions. The Highlight color is used to change the background of alternate rows in the list 
in order to make it more readable. The Selected color likewise makes clear which rows are 
currently selected. The Sounding color refers to the rounded rectangle that is drawn around 
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tones which are sounding in a scale that is either being played back, or has been clicked on by 
the user. The Dark Mode color is the highlight color to be used when the OS is in Dark Mode. 

The five checkbox items in the List row refer to the various data parameters which can be 
shown or hidden. To hide a parameter, simply uncheck it, and the column disappears from the 
database list in all viewer windows. 

Playback Options 

 
By default, scales play back in the following manner: they begin at a starting lowest note 
(1/1) and ascend to the highest note in the scale (usually 2/1, but not always), and then 
descend back down to the starting note (1/1). You can choose to hear scales only ascending, 
or only descending, or descending before ascending, using the first selector. 

You can also choose the MIDI Instrument, the Tonic Note, and the Duration in seconds for 
each note in the scale. By default, MIDI instrument 0 is used (Piano), but it is often useful to 
hear individual tones and intervals with a more sustained sound such as the Reed Organ (MIDI 
patch 21). By default, the tones are fairly short, but longer sustained tones can also be 
helpful to gain a better sense of the sounds of different pitches and intervals. 

Lastly, you can choose to show or hide an overlay display of each scale tone value (number) as 
it plays back. 

 

Changing settings in the Preferences window take 
immediate effect on all open database windows.
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Mac Menu Extension 

 
On Mac, the scales which are currently being displayed in the topmost database window can 
also be organized for quick access using a system menu extension, which appears at the top 
right area of the screen. The scales in the menu can be organized by name alphabetically, or 
by the number of tones. Which scales you access and listen to can be stored in a Recent 
Items list, and you can choose the number of items to remember. 

Check For Updates At Startup 

 
If you purchased ScalaVista via the Mac App Store, then you should be go there to receive 
updates, and you needn’t check for updates through ScalaVista. If you purchased from the H-
Pi Instruments website, then you should keep this option checked, and visit the H-Pi website 
to get updates.  

Note that checking this option lets you know when an update is available from the H-Pi 
website, not the Mac App Store, and keep in mind that updates may be available at the H-Pi 
website before they are available at the Mac App Store. 

Name & Email 

 
Your name and email are used for bug reporting purposes and otherwise remain completely 
private. They are never given to any third party. 

Using the Mac Menu Extension may slow down the database searching slightly, 
because after each search, the menu must be rebuilt. Organizing the menu 

alphabetically is faster than organizing it by the number of tones.

If you purchased from the Mac App Store, then you must 
wait until the update is issued there in order to install it.
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2. The Database 

 

ScalaVista is primarily a database for scales. Unlike previous versions of ScalaVista, beginning 
with version 2, the database begins by downloading the archive directly from the online 
ScalaVista database, which is kept in sync with the Scala Archive maintained by Manuel Op de 
Coul. Below are listed the  

The Demo DB 
The demo version of ScalaVista ships with a small internal database of 25 scales, the purpose 
of which is to demonstrate functionality of the full version of the app. To access the complete 
database of thousands of scales, you must purchase a license for the software either from H-
Pi Instruments directly, or from the Mac App Store. 

The Scala DB 
Once you have purchased ScalaVista, you have access to the complete database of thousands 
of scales which can be found online the H-Pi Instruments website, at https://
scalavista.zentralzone.com, made with permission from the collection of tuning files 
maintained by Manuel Op de Coul, creator of Scala, at the Fokker foundation website http://
www.huygens-fokker.org/scala/downloads.html#scales. Before using the full features of an 
authorized (unlocked) installation of ScalaVista, the scale database must first be created and 
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updated from the online archive. Each of these database actions will be done automatically 
when you purchase a license, and can also be done manually. 

Create Local DB 
After installation, ScalaVista will automatically create a database on startup, and the menu 
option Create Local DB will be disabled. The first database created will be The Demo DB 
described above, which is replaced by The Scala DB full database once a license has been 
purchased. If you ever choose to delete the local database, you need only to select this menu 
option to rebuild the database. 

Delete Local DB 
This menu option allows you to delete the local database, should you ever wish to do so. The 
database can always be recreated using the menu option Create Local DB. 

Update Local DB 
The local database is essentially a personal copy of the database which exists online at 
https://scalavista.zentralzone.com which is itself a searchable version of the Scala file 
archive at http://www.huygens-fokker.org/scala/downloads.html#scales. Because the archive 
is continually expanding, the online database will likewise continually expand; however, your 
local database will not expand unless you voluntarily choose to update it. When you select 
this menu option, a network query checks the online database for any new scales in the 
database, and all new scales that are found in the online archive are downloaded and added 
to your local database. 

Scale Editing 
Using this menu option, you may edit any scale in your local 
database. Note that any changes you make are applied only 
locally at your computer – that is, in your local database. 
Your edits are not made to the online archive. If you wish to 
submit corrections or changes to the existing archive, please 
use the Send an Email menu option and copy the scale data 
into the email along with an explanation of why you have 
made the changes. 
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3. MIDI Playback 

 
Listening to the sounds of different tunings is the most immediate way to absorb their unique 
aspects. ScalaVista lets you listen to entire scales as well as individual tones and intervals via 
internal MIDI playback. Tones will sound according to the options displayed at the bottom of 
the database window: instrument, tonic note, single tones or intervals, and duration. The 
Intervals checkbox toggles between single tones and harmonic intervals. When Intervals is 
checked, the tonic pitch will always sound along with all other pitches. 

LIstening to Individual Tones 

 
To hear an individual tone in a scale, simply point and click on the tone. In the example 
above, 6/5 has been clicked. If the Intervals option has been checked, the harmonic interval 
5:6 will sound. The harmonic interval can also be played by holding down the Option key 
while clicking on a tone. 

Listening to Scales 

When you click on a scale in the database window, the row will be selected, and the scale can 
be then be played back using the Play Scale button, or by pressing the spacebar. Once the 
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scale is playing, you can also stop the playback by pressing the spacebar. If you have chosen in 
the Preferences to display the tone overlay, playback can also be stopped by clicking on the 
overlay. Harmonic intervals can be heard either by checking the Intervals playback option, or 
by holding down the Option key during playback. 

4. Copying Scale Data 
ScalaVista lets you place scale data on the clipboard in the following various ways. Scales 
selected it in the database window can be copied either using Command-C or by selecting 
one of the following options under the Edit menu. 

The keyboard shortcut Command-C works the same way as the menu option Edit > Copy 
Scale Info... > All, that is, all selected data is placed on the clipboard as tab-delimited text 
ready to be pasted into a spreadsheet. 

5. Saving and Exporting 
ScalaVista formerly referenced actual individual files, but beginning with version 2.0, there 
are no actual Scala files, only the data those files contain. This means that the data can be 
saved or exported in .scl or other formats. Currently only .scl and .tonex formats are 
supported. 

Saving Scala Files 
Third party applications may require Scala files to be imported. ScalaVista allows you to 
quickly save any scale as Scala file anywhere you like. Simply use the keyboard shortcut 
Command-S or select the menu option File > Save Scala File. Note that if more than one 
scale is selected in the database window, only the first scale will be saved. 

Exporting Tonex Files 
To export a scale, select the scale in the database window and use the keyboard shortcut 
Command-E or choose the menu item File > Export .tonex File. The .tonex format is an 

Copy as Scala File place a single scale on the clipboard in the Scala file format

Copy as Tones List copy a list of a single scale’s tone values only to the clipboard

Copy Scale Info ... copy all or just one of the database parameters (name, 
description, tone count, tones, created) of a group of scales 
to the clipboard, as tab-delimited text, ready for pasting into 
a spreadsheet
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experimental language for tunings using XML tags. All data from the Scala file is included in 
a .tonex file, in the format as shown in the example scale shown below. 

<tonex> 
	 <scale> 
	 	 <name>Name of the scale goes here, without extension.</name> 
	 	 <description>The scale description goes here.</description> 
	 	 <period>2/1</period> 
	 	 <tones> 
	 	 	 <tone>1/1</tone> 
	 	 	 <tone>9/8</tone> 
	 	 	 <tone>5/4</tone> 
	 	 	 <tone>4/3</tone> 
	 	 	 <tone>3/2</tone> 
	 	 	 <tone>5/3</tone> 
	 	 	 <tone>15/8</tone> 
	 	 </tones> 
	 </scale> 
</tonex> 

The above file is equivalent to the scale file shown below. 

! Name of the scale goes here, with an .scl extension; for example, myscale.scl 
!  
 The scale description goes here. 
 7 
! 
 9/8 
 5/4 
 4/3 
 3/2 
 5/3 
 15/8 
 2/1 

Whereas an .scl file includes the period as the final tone in a scale, and does not include 
1/1, .tonex file includes 1/1 and places the period inside an XML <period> tag instead of 
including it in the scale tones list. 
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6. Sending Tunings to microsynth and Other Apps 
ScalaVista allows you to send any scale directly to other H-Pi Instruments applications without 
the hassle of saving and importing files. To send the scale to the application, the application 
should be running on your system. When you select the Send menu option in ScalaVista, the 
scale is prepared as XML text on the clipboard for the destination application. After selecting 
the Send menu option, simply switch to the destination application, and it will recognize the 
XML text on the clipboard, which has been formatted especially for it. 

Supported Applications 

7. Searching 
The aim of most database applications is to store data in a way that can be easily searched, 
and ScalaVista is no exception.  

Search Local DB 

 
Unlike the limited text matching of the online database, ScalaVista desktop allows easy 
searching for scales by matching text or comparing a certain value of a data parameter, 
including the not option. Notice that when the middle popup value is changed, the third 
popup will change its options to suit the type of data you have selected. For example, 
selecting created changes the following popup options to on, before, and after, because the 
data type deals with the calendar. 

microsynth
A 16 track multi-timbral microtonal synthesizer based 
on the soundfont format

UTE
Universal Tuning Editor microtonal tuning editor, for all 
imaginable MIDI controllers (user-definable)

CSE
Custom Scale Editor microtonal tuning editor, for 
conventional keyboards (legacy application)

TPXE
Tonal Plexus Editor microtonal tuning editor, for Tonal 
Plexus keyboards (legacy application)

Xentone
Xenharmonic Ear Trainer microtonal aural skills practice 
program
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Searching Within Current Results 
Once results have been found, subsequent searches can be done within those results, to home 
in on any desired scale. To do this, simply change the first popup menu to current results. 

 

Advanced Searching  
While simple searching allows you to find whatever you want through a series of steps, the 
advanced search window lets you combine search parameters into one query. Additionally, 
whereas simple searches occur and are not retrievable, advanced searches can be named, 
saved and recalled for future reference.  

To open the advanced search window, click the  plus button next to the Show All button on 
the database window. The advanced search window initially appears with options that look 
almost identical to the simple search: 

By clicking the  plus button at the right, an additional group of search options appears. In 
the example below, two groups of additional parameters have been added. 

Options can be removed by clicking the  minus button to the right of the option group. 

To save an advanced search, click the  triangle at the upper left and select Save. The 
popup menu also allows search file management search duplication, deletion, and renaming. 

To load a saved advanced search, simply select the saved search using the Showing Search 
popup menu. 
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Credits & Resources 
All versions of ScalaVista are designed and programmed by Aaron Andrew Hunt, using Xojo and 
MBS Plugins on a Mac. 

Special thanks to Manuel Op de Coul, author of Scala, the Scala file format, and keeper of 
the Scala archive.  

This documentation was written by Aaron Andrew Hunt, using Apple Pages. 

Check out other Tuning Software using the menu item H-Pi instruments > Get Tuning Software 

Thank you for supporting H-Pi Instruments and ScalaVista. 

©2009-2026 H-Pi Instruments · FOR THE FUTURE OF MUSIC
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